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Shape Sculptor



About this course



Student Notes:



Objectives of the course Upon completion of this course you will learn - How to use the Shape Sculptor application - How to import, analyze, enhance meshes - How to modify them by adding details or deforming shapes



Targeted audience Style designers, Modelers



Prerequisites
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Students attending this course should have knowledge of CATIA V5 Fundamentals
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Shape Sculptor Student Notes:



Table of Contents (1/3) Introduction to CATIA Shape Sculptor Process overview Polygon Modeling Accessing the Workbench The User Interface Using the Compass



General Tools Import Export Display options Highlight Curvature



Selection and Activation Selection Activation
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Table of Contents (2/3) Paint Curve Creating Meshes Generate Mesh Tessellate Rough Offset Boolean Operations



Mesh Edition Editing Meshes Decimate / Refine Smooth / Brush Smooth Delete / Extract / Copy Triangles Slice / Stitch Mesh Intersect Trim / Split
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Introduction to CATIA Shape Sculptor



Student Notes:



In this lesson, you will see some general information about :
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Process overview Polygon Modeling Accessing the Workbench The User Interface Using the Compass
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Process overview Digitized data



In early phases of iterative design cycle A rough model has been created: mock-up, prototype,… The design is validated Next step: tune shape + add details



Polygon modeling
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Rapid Prototyping



Copyright DASSAULT SYSTEMES



NC Manufacturing



Feasibility studies



Tooling design



New mock-up



7



Shape Sculptor Student Notes:



Polygon Modeling Polygon modeling = work on a polygon (a mesh) on screen as if working on a physical mockup. Benefits: working on a screen is cheaper and the result is directly usable in CATIA
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Analyze shape
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Add details



Modify shape
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Accessing the Workbench
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At any time, the current workbench is indicated by an icon on the right hand side of the screen.
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The User Interface
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Using the Compass (1/3) The compass is used to: Select a plane or direction to perform an action Make it a privileged plane Apply a transformation to one or several entities. Hit F5 several times to switch from x0y to y0z then to z0x. The compass also has an associated popup



This toolbar helps to swap from one selection to another



In this toolbar you have the choice of the main plane/direction Activate the main plane that is the most visible on your viewing position Use a plane or 3 points to define a plane or direction
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Reset the compass in xyz mode Switch the compass from not linked to linked to the entity When linked to an entity, create the compass plane for later use
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Using the Compass (2/3)



Student Notes:



Positioning the compass: You may drag and drop your compass to: A curve: The plane normal to the curve will be defined. A surface: The plane tangent to the surface where you dropped the compass will be defined.



The compass is then switched from x,y,z to a u,v,w trihedron. Then by hitting F5 you will flip from u,v to v,w then w,x plane definition.
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Once a plane or direction is selected, you may use its definition in relevant action. Each time you find the following icon, use it to project control points within the “Control Point” menu
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Using the Compass (3/3) Display according to a main plane: Just click the x, y or z letter to display the corresponding y0z, z0x and x0y view Click the same letter again to reverse the view direction Pan the display by click+hold on x,y or z axis and moving the mouse Rotate the display by click+hold on the arcs of circle and moving the mouse Z translation Y rotation X rotation



X translation Z rotation



Y translation
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Apply a transformation to one or several entities: Link the compass to an entity and then use the axes/rotation circles from the compass, the entity will physically move in your model You can also manipulate several entities: first position your compass on an entity, then multi-select the entities to be moved and act on the compass To reset the compass drag and drop it on the absolute xyz axis (lower right of the screen)
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General Tools



Student Notes:



In this lesson, you will learn about:
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Import Export Display options Highlight Curvature
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Import (1/2) You can read any mesh available in STL format (text or binary) STL format was originally designed for rapid prototyping by stereolithography but it has become a common exchange format for triangular meshes The Import command of Shape Sculptor is the same as in DSE but limited to STL meshes Meshes can be imported from a file stored in an ENOVIA or a SMARTEAM base
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• If you recall several meshes you may choose to group them into a single mesh



• You may preview the imported mesh and select a part of it by a containment box
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• Get information in the statistics window (number of points, mesh dimensions…) • Sampling: not available for the import of meshes. • Scale Factor: the scan operation is very often performed on a scaled model, you may want to work on real size model, apply the given scale factor • File Unit: your CATIA session is set up for a given unit. The file you import comes from the outside world and may be digitized in another unit. Set up the proper unit before importing the file
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Import (2/2) The ‘ More…’ button gives access to advanced possibilities Warning: you have to click Apply before you can close the dialog box by OK If you click Cancel the selected mesh is not imported
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• System applies to the operating system (Unix or Windows NT) used to generate the binary data: select Same if you know you are using the same operating system as the one used to generate the binary data, Other for the other way, Unknown if you have no indication. • Free Edges is used to create or not the scans representing the free edges of a cloud of points. • Facets: not available in Shape Sculptor environment
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Export You can export a mesh to a new STL file or export its vertices only to a new cloud of points Multi-selection available to export several meshes to several files (option Distinct) or to a single file (option Grouped).
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Axis system: export mesh in Absolute or Current axis system



Save as Type: •Ascii free: point coordinates according to ISO standard •Ascii RGB: point coordinates + RGB color code for each point •Cgo: point coordinates only, readable in CATIA V4 CGO application. •Stl: binary STL file.
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! ! ASCII generated by Digitized Shape Editor/CATIA ! ! Without Scans ! Point Format = 'X %f Y %f Z %f' ! ! Total number of points = 5453 ! X 0.580073 Y -0.500810 Z -0.383616 X 0.580837 Y -0.499042 Z -0.385223 X 0.580386 Y -0.504416 Z -0.382684 CGO: X 0.590524 Y -0.487657 Z -0.377479 X 0.583682 Y -0.501518 Z -0.386112 285 X 0.588214 Y -0.494585 Z -0.373934 431.198151 -674.281799 107.692230 X 0.583410 Y -0.505760 Z -0.384708 431.198151 -674.628418 108.223984 X 0.588975 Y -0.505897 Z -0.370677 431.198151 -675.001831 109.109077 X 0.592607 Y -0.485534 Z -0.373024 431.198151 -675.635742 110.533531 X 0.598624 Y -0.496144 Z -0.380670 431.198151 -676.545776 112.480850 X 0.584484 Y -0.504205 Z -0.385984 431.198151 -677.638306 115.074150 X 0.590717 Y -0.492391 Z -0.369409 431.198151 -677.688721 115.194672 X 0.602287 Y -0.494163 Z -0.375520 431.198151 -677.732605 115.291199 X 0.598038 Y -0.509153 Z -0.376080 431.198151 -679.014343 118.206978 431.198151 -680.101318 120.927452
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Display options The Cloud Display Options is the same as in DSE but it is limited to the options which apply to meshes. The options can be found from the properties of mesh.



For meshes there are 6 options which can be combined: •Triangles: To display the facet edges •Vertex: To display the vertices (nodes) of the mesh •Flat: Shaded display of the facets, each facet has a uniform color, it is an exact display •Smooth: Shaded display with Gouraud shading, the surface looks smoother than it is •Free Edges: To display the mesh boundaries (useful to detect holes) •Non-manifold: To display non-manifold edges (edges shared by more than 2 facets)
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All the colors, the edge line types and the vertex markers can be changed by Edit/Properties.



Triangles



Smooth
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Flat



Smooth + Triangles Smooth + Vertex



Smooth + Free Edges
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Highlight The Highlight analysis option of FreeStyle is available in Shape Sculptor It requires the display mode to be turned to Shading with Material A manipulator is displayed and can be used to tune or animate the highlight lines You can also display lines corresponding to a constant angle step



You can simulate the reflection of parallel stripes (default) or the reflection of a grid:



The analysis can be applied to a mesh or to the whole part You can activate a light source manipulation tool to tune and animate the highlight lines.
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You can activate anti-aliasing to smooth the highlight lines



Copyright DASSAULT SYSTEMES



The line density (number of lines), thickness (width) and sharpness (blur) can be controlled
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Curvature



Student Notes:
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Shape Sculptor offers a specific curvature display tool It computes a smooth distribution of the curvature from the flat facets and shows it according to a color scale. The values corresponding to the color threshold can be tuned with sliders.
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Selection and Activation



Student Notes:



In this lesson you will learn about:
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Selecting vs Activating Brush Select Box Trap Curve Select Hole Select Flood Select Invert Select Activate Activate All
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Selection (1/2) Selection is used to choose the area of the mesh on which you want to apply an action. Examples:



Only area is refined Mesh



Selected area



Only area is deleted
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As in Digitized Shape Editor and Quick Surface Reconstruction workbenches you can activate a part of a mesh. Activation is used to extract the part of the mesh on which you want to work, the rest is temporarily hidden and cannot be accessed unless it is reactivated. Example:



Mesh
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Activated area



Only the area is activated The rest is ignored
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Selection (2/2)



Student Notes:



The selection of a mesh area can be done by various methods: Brush select: the brush is shown as a circle, its radius can be changed, brushed facets are selected and highlighted Box trap: the facets included to the 3D trap are selected Curve select: the facets located inside a closed set of curves are selected. The control key must be used for the multi-selection of curves. Hole select: the free sides of the mesh are highlighted and can be selected. Flood select: a whole continuous domain is selected
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Invert select: selected and non-selected facets are swapped
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Activation



Student Notes:



A selected area can be activated Activate: The selected elements are kept, the others are made invisible
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Activate All: The whole mesh is redisplayed



Activation can also be done with the Activate command of Digitized Shape Editor (DSE) or Quick Surface Reconstruction (QSR)
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Creation



Student Notes:



In this lesson, you will learn about:
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Creating Curves 3D Curve Paint Curve Creating Meshes Generate Mesh Tessellate Rough Offset Boolean Operations
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Creating Curves



Student Notes:



In Shape Sculptor curves may have various different objectives: Define the limits of an area to select Example: Curve Select



Define the shape of a modification Example: Curve Sculpt
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Define the limits of a shape deformation Example: Emboss, Push/Pull
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3D Curve (1/2) The same 3D Curve tool as in DSE, QSR or FreeStyle is available in Shape Sculptor It can be used to draw curves directly on a mesh Warning: only selected points are exactly on the mesh.



• Creation type: 3 options available • Points handling: you can add or remove a point, or add or remove a constraint between a point and a support element. • Disable geometry detection: selected points are taken in the current plane even when an element is selected. • Options: smoothing parameters available with the option “ Near points”
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• Smoothing options: also available with option “Near points”
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Chord length



Uniform



Select existing points on a mesh or on any existing element (curve, point…) or select new points taken in the current privileged plane (defined by the compass)
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3D Curve (2/2)



When a point is constrained on a curve you can move it along the curve with manipulators.



Right-click a point: - to edit its position in space or on its support element -to impose a tangency or a curvature



Copyright DASSAULT SYSTEMES



- to remove or constrain the point
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Right-click the curve tangent (green arrow) to access tangent definition options
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Paint Curve The Paint Curve command allows to draw a curve on a mesh. You have to select the support mesh, then press the left button of the mouse and draw the curve on the mesh. You can use CTRL key to create a closed curve. You can double-click the last point to exit the command and create the curve (or use the OK button of the dialog box). The command opens a specific toolbar: With/without fitting: Show/Hide dialog box with fitting parameters:
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No fitting (polyline)
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With fitting (smooth curve)
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Creating Meshes



Student Notes:



The mesh is the main object manipulated in Shape Sculptor You may import a mesh, but you may also create additional meshes To repair an existing mesh: fill a hole, replace a part of it,…



To convert a surface to a mesh and edit it with Shape Sculptor tools,
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To create an offset mesh



Copyright DASSAULT SYSTEMES



30



Shape Sculptor Student Notes:



Generate Mesh Generate Mesh can be used to tessellate points of an existing mesh It is mainly used to correct defects, for example fill holes The area to re-mesh has to be selected A temporary surface is computed over the selected points, then it is tessellated to create a mesh The created mesh is larger than the selected area, it has to be trimmed afterwards if needed
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Selection of area to process
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Trimming Point and Curve tolerances: used for the computation of the temporary surface Tessellation: used for the computation of the mesh from the surface
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Tessellate You can convert surfaces to meshes according to a given tolerance This can be useful to switch from conceptual design to polygon modelling



Sag: maximum distance between mesh and support surface



Copyright DASSAULT SYSTEMES



Step: maximum edge length, to avoid long and thin triangles in flat areas



no edge length
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edge length = 10mm
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Rough Offset Rough Offset handles large offset values leading to drastic shape changes You may offset the mesh on one or both sides



Granularity: accuracy of the computation. •With a low granularity value: all details are taken into account, the resulting mesh counts many triangles. •With a large value: the result is rough, some details may be lost.
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A white arrow indicates the side for a positive offset value.
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Boolean Operations You can perform Boolean operations on two meshes. The meshes must be manifold and the intersection of the meshes must result in one or several closed contours.



Mesh A



Mesh B



Once you select the meshes, you can see two arrows. Each arrow shows the side of the other mesh that will be kept. The color of the arrow shows the orientation.
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Green: Outside orientation Red: Inside orientation
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You can define the operations between meshes by changing the arrow directions.
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Mesh Edition



Student Notes:



In this lesson, you will learn about:
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Editing Meshes Decimate / Refine Smooth / Brush Smooth Delete / Extract / Copy Triangles Slice / Stitch Mesh Intersect Trim / Split
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Editing Meshes



Student Notes:



Shape Sculptor offers a variety of tools for mesh edition These tools have different objectives: Add or remove triangles Delete Triangles Extract Triangles Copy Triangles



Optimize the data size, i.e. optimize the number of triangles Decimate Refine



Improve mesh quality Smooth Brush Smooth
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Edit mesh using external elements Slice Mesh Intersect Trim/Split Stitch
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Decimate / Refine Decimate can be used to reduce the number of triangles in a mesh or in an area of a mesh (if it has been selected) You may choose between 2 modes: Chordal Deviation preserves the shape of the model while Edge Length gives a more uniform distribution of the vertices.



You can choose the objective of the decimation to be a Maximum edge length or simply a Percentage of the number of triangles. You can activate the Free edge tolerance option to preserve the shape of the free edges (useful to maintain continuity with surrounding elements). The Analysis option gives a feedback on the actual deviation between the original and the decimated mesh.
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On the contrary you can Refine a mesh or an area of a mesh to increase the number of triangles The elements to refine must have been selected first.
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When you click Apply each selected triangle is divided into 2 new triangles
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Smooth / Brush Smooth Smooth can be used to correct shape defects on a mesh Smoothing is done step by step until a correct result is reached Warning: the mesh is actually modified, some points are moved Steps and Pressure : can be increased to accelerate the smoothing process Preserve volume : use a smoothing method which avoids moving all points to the same side of the surface Smooth boundaries : keep the shape of the free edges of the mesh Deviation: information of the applied deformation Tolerance: maximum accepted deviation for each click on the Apply button.



Copyright DASSAULT SYSTEMES



Brush smooth does the same in real time on triangles selected by brush
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Radius : size of the brush used for selecting triangles Pressure : smoothing strength (like above)



Type : similar to above volume preservation option • Flatten: the smoothed area tends to get flat, • Round: the smoothed area remains curved.
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Delete / Extract / Copy Triangles Selected triangles can be Deleted, Extracted or Copied: Delete : the selected triangles are deleted, leaving a hole in the mesh



Extract : the triangles are deleted from the mesh but created as a new mesh
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Copy : the selected triangles are created as a new mesh but they are not deleted from the mesh
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+



+
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Slice / Stitch Slice : create new free edges along curves or scans The mesh is divided into cells



A cell can be selected by Flood Select to be activated, refined, ...



On the contrary Stitch can be used to merge meshes You have to select the common free edges You can specify a tolerance between the edges if they do not superimpose exactly.
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1 2
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If the distance between the selected edges is greater than the tolerance the edges are not merged
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Mesh Intersect
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You can create the intersection between a mesh and a plane, a surface or another mesh The intersection is created as a smoothed curve or can be used to slice the mesh
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Trim / Split You can cut a mesh by scans, curves, planes, surfaces or other meshes The selected cutting elements must define non-ambiguous areas of the mesh, otherwise you get an error message



Projection specifies the direction to project the cutting curves or scans to the mesh Preview shows the intersections between the selected mesh and cutting elements
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Trim: the mesh is divided into sub-meshes and only selected areas are kept Split: the mesh is divided and all sub-meshes are kept.



With Trim: you can select the area to keep or the area to remove by selecting the corresponding icon and clicking on the mesh Remove All removes all the icons.



In all cases sub-meshes can be grouped into a single mesh or created as distinct meshes. Keep initial: when active the input mesh is kept and made invisible.
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Modeling Shapes
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In this lesson, you will learn about:
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Modeling Shapes Control Points Project Curves / Extract Curves Curve Sculpt Emboss Push/Pull Surface Sculpt Sharp Edge Grid Modeling Interactive Grid Modeling Mesh Morphing
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Modeling Shapes After editing the mesh you can use it as a support for modelling In Shape Sculptor modeling means: Add details Or Modify the shape globally In addition you may access the modeling tool of FreeStyle to modify curves and surfaces by their control points



Curve and Surface modification
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Addition of details on shape
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Global shape deformation
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Control Points (1/2) Control Points are used to modify the shape of a surface Select the control points that are free to move (the others remain fixed) Choose a direction for moving the control points that you drag If several control points are free to move, define a deformation distribution law Choose the possible directions with the icons of the dialog box as follows: Perpendicular to the privileged plane Along directions defined by the segments connecting the control point Parallel to the normal direction of the curve at the considered point In the privileged plane (change the privileged plane if necessary)
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Parallel to the tangent direction of the curve at the considered point
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In a local plane automatically detected by the system to preserve tangency directions (for example to allow the surface to be tangent to its symmetric)
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Control Points (2/2) Define a deformation distribution law with the icons of the dialog box as follows: Deformation performed on one of the connections is propagated on the others according to current diffusion and cross diffusion laws All the selected points are equally moved The deformation distribution on selected points is linear from the pulled point (maximum deformation) to the last selected point (no deformation) The deformation law is concave, i.e. the deformation attenuates quickly (local deformation) The deformation law is convex, i.e. the deformation attenuates slowly (more global deformation)
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The possible directions are shown by green arrows when you bring your pointer close to a control point or a line.
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The deformation varies slowly at both ends and quickly in the middle



When you select and drag an arrow, the control point (or the line) becomes the dragged point (or line) and is moved in the direction of the arrow. The other selected points are moved according to the chosen deformation law. A GSD point can be created by rightclicking on a control point and selecting “Keep this point”.
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Project Curves / Extract Curves You can project curves to meshes The projection direction can be defined: With the compass Or as being the view direction Or as being the normal to the mesh



You can create free sides as curves The curves can be interpolated or fitted depending on the option chosen in the tool palette Cutting points can be added by moving the square handle along the free side



Activate Fitting
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Display fitting parameters



Select free side
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Move square handle with mouse to add cutting points
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Curve Sculpt You can use a curve lying on a mesh to locally deform a mesh and create a groove or slot. The depth and width of the groove can be dynamically controlled Profile defines the shape of the groove Control width



Dynamic: activate dynamic display of the result whenever you change a parameter.



Influence area corresponds to width.
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Offset corresponds to the depth.



Control depth
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Show: display the handle to control width (magenta). Refine: to add facets and improve local mesh quality. Uniform: the width can be constant or defined by several width values. If option is deactivated you have to use handles to add and set width values.



Show: display the handle to control width (cyan) Uniform: the width can be constant or defined by several width values. If option is deactivated you have to use handles to add and set depth values.
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Emboss Emboss can be used to create a boss or pocket The user interface is similar to the previous one The direction needs to be specified
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Width handle in magenta
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Depth handle in cyan
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Push/Pull
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You can deform a mesh by pulling one of its vertices in a given direction The deformation area is limited by a limit contour The user interface is again the same as before (cyan handle for depth or height, magenta handle for width)
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Surface Sculpt
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You can define a part of a mesh by a closed set of curves and modify it as if it was a surface with control points The user interface is the same as the Control Points command The continuity between the deformed and non-deformed areas can be controlled.



Copyright DASSAULT SYSTEMES



51



Shape Sculptor



Sharp Edge
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Sharp Edge can be used to re-create sharp edges that have been filleted You have to specify the fillet width with the magenta handles Then you must set the position of the sharp edge with the cyan handles
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Grid Modeling (1/2)
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The concept of grid modeling is to immerse the mesh into a box and deform the mesh by deforming the box You can choose the number of sections in each of the 3 directions of the box Then you can deform the mesh by moving or deforming sections with graphic handles
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Grid Modeling (2/2) The dialog box offers a large number of possible modes Move, scale or rotate sections



Switch to face deformation mode (similar to Control Points)
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Select family of sections to manipulate
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Interactive Grid Modeling
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Interactive Grid Modeling is similar to the previous command The difference is that the modeling box is defined according to the screen directions instead of the principal directions The mesh is selected by a trap which gives the three directions of the box
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You can deform the mesh using the target elements. The deformation area can be limited by a limit element. You have to specify the fillet width with the magenta handles Then you must set the position of the sharp edge with the cyan handles
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Influence area corresponds to width. Show: display the handle to control width (magenta). Refine: to add facets and improve local mesh quality. Uniform: the width can be constant or defined by several width values. If option is deactivated you have to use handles to add and set width values.
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Terrain Modeling
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In this lesson, you will learn about:
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Modelling Terrain Mesh Enrichment Z Level Mesh Z Level Map Multi-sections Slice
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Modeling Terrain
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Shape Sculptor offers a variety of tools to edit the mesh. These tools have different objectives: Mesh Enrichment Z Level Mesh Z Level Map Multi-sections Slice
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You cannot see these commands in Insert menu by default. You have to use one of these methods to see the toolbar Select Tools > Customize Right-click any icon in any toolbar Select View > Toolbars
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Shape Sculptor Student Notes:



Mesh Enrichment You can improve the quality of meshes by inserting points from a cloud of points. Mesh: Mesh to be enriched. Origin: The cloud from which the points are to be taken. The parameters area corresponds to constraints.
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Threshold: It is a maximum acceptable distance between the mesh and the points to be inserted. The points that are at a distance greater than this parameter are not inserted. Direction: It is a projection direction of a cloud onto the mesh. You can select the direction from the contextual menu.
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Shape Sculptor



Z Level Mesh



Student Notes:



You can create a mesh from a scan of points with respect of Z Level Stream. A Z Level is a scan of points with the same altitude.
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The mesh passes through all points and respects the Z level stream.
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Shape Sculptor Student Notes:



Z Level Map (1/3) You can create planar sections of a mesh on major and minor planes.



Element: display the handle to control width (magenta). Origin: It is a reference point to define the major and minor planes.
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The parameters area corresponds to planes.
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Lower Distance: It is a distance on the Z-Axis between the first (lower) plane and the origin point. Step: It is a distance between two planes. Number: It is a number of major planes. It is automatically computed to the upper limit of the input elements. Sag: You can specify it if you have selected surfaces or volumes. You can choose the colors of the major and minor planes. You can hide or show the planes and annotations.
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Shape Sculptor



Z Level Map (2/3)



Student Notes:



The resulting scans are projected on a reference origin plane to create a Z Level map with annotations.
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You can change the display mode of the scan using the contextual menu.
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Shape Sculptor



Z Level Map (3/3)



Student Notes:
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You can extract the major and minor scans.
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Shape Sculptor Student Notes:



Multi-sections Slice You can slice a mesh by other meshes. You can select more than one mesh at a time. The intersection line between meshes must be closed.
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The slices are computed and displayed in different colors.
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Multi-section slices are created in the specification tree.
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Shape Sculptor Student Notes:



To Sum Up In this course you have seen: How to use the Shape Sculptor application How to import, analyze, enhance meshes How to modify them by adding details or deforming shapes
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CONGRATULATIONS ! You have completed the fundamental training on Shape Sculptor
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Shape Sculptor 

Jan 19, 2009 - 20. Curvature. 21. Recap Exercise 1- Hair Dryer. 22. Selection and Activation. 23. Selection. 24. Activation. 26. Creation. 27. Creating Curves.










 








marco dessardo INSERTS - dessardo, sculptor 

The Â«Penta ProjectÂ» is a multiple sculpture project. In different countries, Penta elements are created on the proposed sites, inserted in local environment.










 








erik dietman sculptor classicus wurttembergischer ... AWS 

If you want to possess a one-stop search and find the proper manuals on your products, you can visit this website that delivers many Erik Dietman Sculptor. Classicus Wurttembergischer Kunstverein Stuttgart Musee Dart Moderne De Saint. Etienne. You ca










 








Shape magazine 

Page 1. Shape magazine. Mensuel. DÃ©cembre 2013.










 








Mouse Skull Mean Shape and Shape Robustness Rely on Different 

Feb 15, 2019 - Ceferino VarÃ³n-GonzÃ¡lez1,2, Luisa F. Pallares3, Vincent Debat1â€  and Nicolas Navarro2,4*â€ . 1 Institut .... landmarks located on the mid sagittal plan) recorded on each skull ..... patterns of shape variation described by G result 










 








Digitized Shape Editor .fr 

Jan 19, 2009 - from scanning a car door. Tessellated mesh created in DSE workbench. Characteristic curves extracted in DSE workbench. Designing parts in ...










 








REN SHAPE 450 

2,800 psi. Compressive Modulus. 135,000 psi. Tensile Strength. 2,300 psi. Glass Transition Temp. 205Â°F. Coefficient of. Thermal Expansion. (-22Â° F to 86Â°F).










 








marco dessardo I-Park Foundation, Inc. KQ Series - dessardo, sculptor 

Jul 7, 2011 - An important part of the I-Park mission is the creative engagement of its natural environment, in the broadest sense of that term. To mark the ...










 








Digitized Shape Editor 

It also describes the general layout of CATIA V5, and ..... Choose a value to ignore ... the binary data: select Same if you know you are using the same operating ...... Use the Discretization option to limit the number of points of the target elemen










 








REN SHAPE 460 

foundry patterns, vacuum form molds, architectural and automotive die models, tooling aids and fixtures, and other applications requiring fast machining and ...










 








Realistic Shape Optimizer 

Jan 19, 2009 - Student Notes: ... The deformation has to be applied to the CAD part to get the ... the surface(s) can be any CATIA V5 or imported surface.










 








The Shape of Things 

Both $6.00 Airmail. Great Lakes Aircraft Company. Box 5974, Dept. B, Cleveland, Ohio 44101. AIRPLANE SUPPLY CENTRE. (Ed's Western Aviation Sales Ltd ).










 








Generative Shape Optimizer 

Jan 19, 2009 - How to Create a Junction: Manual Coupling (1/2) ... The manual coupling : Coupling Curve .... Fillet radius: It is the radius of the surface. 3.










 








CATIA Generative Shape Design 

Sep 19, 2008 - Create two Arcs of Radius 70 mm in Sketch.4 on YZ plane. Create a ...... manual coupling with definition of the coupling curve(s). Automatic ...










 








Digitized Shape Editor 

Jan 19, 2009 - Do It Yourself. 16. Master Exercise Step (3): Creating the curves and exporting the result. 20. Do It Yourself. 21. Added Exercise - Hair Dryer. 30.










 








Imagine and Shape 

Jan 19, 2009 - The Curve sketching option allows you to draw and refine a curve in the ... You can iterate by drawing as many sketches as you want; the curve ...










 








Realistic Shape Optimizer 

Jan 19, 2009 - A design part has been analyzed by a finite element method. .... standard update mechanism of CATIA (automatic or manual update with ).Missing:










 








LESMILLS SHAPE FEV 












 








REN SHAPE 5008 

REN SHAPE 5008 is a tooling board specifically designed for use in vacuum forming. It is designed for use up to 250Â°F and is well suited for building vacuum ...










 








CATIA Generative Shape Optimizer 

Jan 19, 2009 - CATIA Training. COPYRIGHT ... CATIA Generative Shape Optimizer ..... Define the geometrical set â€œassemblyâ€� as the in work object. â€¢ Select.










 








Digitized Shape Editor 

Jan 19, 2009 - Free Edges is used to create or not the scans representing the free edges of a ..... You may need to alternate the use of this action with the flip.










 








CATIA Generative Shape Design 

Sep 19, 2008 - Recap Exercise: Advanced Wireframe Geometry. 48. Wireframe ... Recap Exercise: Adaptive Swept Surface. 103. Creating ...... Page 150 .... practices. Many times healing is used on parts imported from other CAD systems.










 








CATIA Generative Shape Design 

Sep 19, 2008 - CATIA Generative. Shape Design ...... constraint on the intersection computed by CATIA. ...... design surface parts in the context of an assembly.










 








Generative Shape Optimizer .fr 

Jan 19, 2009 - In this illustration, we are going to show you how to develop the extremum .... If you use the â€œdevelop-projectâ€� option, the end of the algorithm is ...
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